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1. Introduction 
 
The Gem Drive Studio software tool has been developed for the parameterization and 
commissioning, from a PC and via a serial link RS232, of series XtrapulsGem, XtrapulsPac and next 
generation drives. 
Gem Drive Studio is a multi-axis software that allows the parameterization of all drives in a same 
application via one single connection. 
 

2. System 
 
2.1 Minimum configuration 
 
 Pentium III processor, 
 512 MB RAM, 
 15" screen, 256 colour screen, 1024x768 resolution 
 Keyboard + mouse 
 Windows XP Service pack2 operating system 
 Microsoft .NET Framework V3.5 or V4.0 installed 
 55 MB available on hard disk 
 RS232 cable or USB/RS232 adapter cable or CAN IXXAT peripheral. 
 
2.2 Restrictions 
 
Under Windows 7 Professional 64 bit, the Service Pac 1 must be installed. 
 
Important  note:  If  using  a  USB/RS232  adapter,  it  is  highly  recommended  to  choose  an  industrial 
product  rather  than  a  consumer  product,  because  of  reliability  and  performances.  It  is  in  particular 
mandatory to have shielded cables (see application note regarding the use of USB/RS232 adapters). 
 

3. Installation 
 
3.1 Installation procedure 
 
1/ Unzip the GemDriveStudioVx.xx.zip file in a directory. 
2/ Execute the Setup.exe file from this directory and follow the installation instructions. 
 
 
3.2 Important notes 
 
1/  Before  installing  the  new  Gem  Drive  Studio  version,  we  strongly  advise  to  uninstall  the  former 
versions:  
 
 Select "Parameters", then "Control panel" in the "Start" menu of Windows, 

 
 Click on the "Add/remove program" icon and select "Gem Drive Studio" in the list, then click on 

"Add/remove". 
 
Former versions can also be uninstalled from the menu "Start/Gem Drive Studio/Uninstall Gem Drive 
Studio". 
 
2/ If the installation program is detecting that files already installed on the hard disk are more recent 
than those of the installation, we advise to keep these hard disk files. 
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3/  For  a  correct  operation  of  the  software  tool,  use  ONLY  the  dot  "."  as  decimal  separator  when 
entering digital values. Do not use any thousands separator. 
 
4/ The installation of Gem Drive Studio under Windows XP, Vista or Seven requires the opening of an 
Administrator  session.  The  software  can  later  be  used  by  users  having  rights  but  not  mandatorily 
administrator rights. 
 
5/ Import module of old projects 
 
From version 4.X of the software, important changes have been introduced into the organization of the 
installed files for allowing the use of the software by people without administrator rights. Consequently, 
some  files  (configuration,  passwords,  motors,  projects)  which  have  been  created  with  a  former 
software  version  (3.X)  cannot  be  accessed  anymore  from  version  4.x.  But  a  module  has  been 
implemented into the installer which allows importing these older files. 
 
6/ For any complementary information regarding the installation, please see the "readme.txt" file. This 
file also contains the historical background of the software evolutions.  
 
 
3.3 CANopen drivers 
 
- IXXAT drivers 
 
These drivers allow managing the CAN peripherals developed by company IXXAT. 
The user is free to install them or not. 
 
a/ The user installs the drivers: 
 
If an older version of the IXXAT drivers already exists in the PC, the installer will suggest uninstalling 
the old drivers before installing the new ones. It is recommended to accept this procedure. 
At the end of the installation, the user will get suggested to reboot the PC. This step should be 
postponed but it is mandatory for using the new drivers. 
 
b/ The user does not install the drivers: 
 
If IXXAT drivers are already installed on the PC, they will not be uninstalled. But the CANopen IXXT 
peripheral will not be proposed in the Gem Drive Studio software. 
 
Any additional information regarding the installation can be found in the "readme.txt" file. This file also 
contains a history of the software evolutions. 
 
If a problem occurs when installing the software and/or during the driver commissioning, please refer 
to Chapter "Troubleshooting". 
 
3.4 EtherCAT® drivers 
 
The communication via EtherCAT® requires the installation of the WinPcap software. This software is 
now automatically installed together with Gem Drive Studio. 
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4. Starting the software 
 
After installation of the software, 3 new icons are displayed on the desktop: 
 
 a "GemDriveStudio" icon for starting the main interface, 
 an "Oscilloscope" icon for starting the digital oscilloscope, 
 a "Dialog window" icon for launching a dialog terminal. 
 
Note: When launching the software for the first time, if the message "Unexpected error" is displayed, 
click with the right mouse button on the launching icon and select "Execute as administrator". 
 
4.1 The user levels 
 
The software contains three user levels: 
 
a/ The Administrator, who can: 
 
 create and manage a project, 
 apply a pre-defined drive configuration, 
 read and modify parameter values, 
 start the execution of motions, 
 change the passwords. 
 
The administrator's default password is: admin. 
 
b/ The "Level 1" user can: 
 
 read and modify parameter values, 
 start the execution of motions. 
 
The Level 1 user's default password is: user1. 
 
c/ The "Level 2" user can only read parameters (monitoring).  
 
This user level does not require any password. 
 
4.2 Password modification 
 
Passwords can only be modified by an administrator by clicking on the button "Change password" in 
the ID window accessible from the "Tools / User identification" menu. 
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4.3 User interface 
 
The  user  interface  allows  the  parameter  display  and  modification  of  the  application  drives.  This 
interface is made of various windows accessible via menus or buttons. 
 
All windows, except for the oscilloscope and terminal ones, are contained in the main window: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The treeview presents the items for each drive of the bus. The functions accessible via this tree are 
the  parameterization,  the  sequence  edition,  the  axis  control,  the  programming  and  the  information 
display (I/Os, status, controls, ...). 
 
The  central  area  contains  the  parameterization,  control  or  information  windows  selected  in  the 
treeview. 
 
Non-accessible  items  with  regard  to  the  user  level  correspond  to  non-implemented  functions  in  the 
drive and are disabled or hidden. 
 
4.4 Help display 
 
In all parameterization windows, The F1 key displays a context help. 
 
4.5 Interface language 
 
In the menu "Tools/Select language", the operator can select the interface language among English, 
French and German. The software must be re-started to make this change effective. 
 
4.6 Configuration of the software 
 
In the menu "Tools/Software configuration", the operator can define various displays for the navigation 
tree and for the control window. 
 
 

 Menu area 

Shortcut button area 

Treeview Display and parameterization windows area . 
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5. Communication principles 
 
The software is made of several independent modules. Each module can communicate with one of the 
application drives via a communication server.  
 
The communication with any of the application drives is established by connecting with one of them 
via  a  serial  link  or  a  CANopen  link  (requires  the  installation  of  a  CAN  IXXAT  card  in  the  PC).  The 
communication between the connected drive and all others is ensured by a CAN link only.  
 
 

 
  
The various software modules consist of autonomous and independent executable programs. These 
programs can be independently launched or from the main module. 
 
 The server is automatically started when a client module tries to establish a communication with 

a drive. 
 
 The server commissions the drivers of the peripherals. 
 

Serial port 
CAN or 

EtherCAT®

Drive 1 Drive 2 Drive N ... 

Communication server 

Client module 

  
  
 

Gem Drive 
Studio 

Client module 

  
  
  

Terminal 
 

Client module 

  
  
  

Oscilloscope 

 

CAN bus between the N drives 
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 The  peripheral  used  is  released  when  the  last  client  is  disconnected,  but  the  server  remains 
active. 

 
 The format of the exchanged data is always the same, whichever the selected communication 

type (RS232 or CANopen). 
  

6. Object dictionaries 
 
6.1 Introduction 
 
A drive parameter corresponds to an object accessed via an Index and a Sub-index. 
Each drive contains a dictionary grouping all objects used by the drive. In the dictionary, each object 
(parameter) is identified and described. So, for each object, the description contains: 
 
 the index, 
 the sub-index, 
 the name, 
 the type, 
 the access type (reading, writing, reading only or writing only), 
 the possibility or not to map the object in a PDO message, 
 the variation range, 
 the behaviour (modification when enabled or disabled, saving into the EEPROM, ...), 
 the category (motor parameter, regulator, communication, application, ...). 
 
In fact, this dictionary contains the information which are generally contained in the EDS (Electronic 
Data Sheet) file available with any product complying with the CANopen protocol standard. But the 
information contained in the drive dictionary are more complete than those of the EDS file. 
 
Concretely, an object dictionary is an XML file containing the object list for a given drive version. The 
file name corresponds to the object dictionary version (example: 0x02000103.xml). 
 
6.2 Use 
 
The  object  dictionary  is  used  by  the  software  for  communicating  with  a  drive.  The  dictionary  files 
corresponding to the various drive versions are included in the software package. 
 
If the required dictionary is missing in the dictionary library of the installation directory (for a new drive 
version for example), the software makes it possible to add a new dictionary in the library by importing 
it. 
 

one  or  several  object  dictionary(ies)  into  the  software,  select  the  menu  "Tools/Embedded  EEDS 
catalogue"/"Import new embedded EEDS file". 
Select, on the disk, a dictionary file (.xml format) or a compressed file (.Zip format) containing several 
dictionary files. 
After validating, the new file(s) will be added to the dictionary library. 
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7. The projects 
 
7.1 Introduction 
 
A project consists of a representation of the application with all the drives connected to the fieldbus. 
Thus, the project structure makes it possible to directly start the communication with one or several 
drives  of  the  application.  It  also  allows  the  backup  of  the  parameter,  sequence,  configuration  and 
programming files of each drive.  
 
The authorized user (administrator) only can define a project. 
 
The project organization on the hard disk is the following: 
 
 a < project _ name >.prj file containing the project composition, 
 possibly a < project _ name >.back file allowing the management of the project modifications, 
 sub-directories  which  name  is  the  one  of  the  project  drives  and  which  contain  the  parameter, 

sequence, programming, ... files for each drive. 
 
The software can be started by a double click on an existing project file. 
 
7.2 Creation of a new project 
 
The  creation  of  a  new  project  only  requires  the  selection  of  "New  project"  in  the  menu,  then  the 
selection of a name and an output directory on the disk. 
 
A description text of the project can also be entered when the project is created. 
 
Further, for the display/modification of the name, the output directory or the project description, select 
"Project" then "Properties" in the menu bar. 
 
Note: For opening the project directory, select "Project" then "Open the directory". 
 
7.3 Adding drives to a project 
 
A drive is added to the project by a right mouse click on the project in the tree and by selecting "Add a 
device", or from the menu bar by selecting "Project" and then "Add a device". 
 
A drive list with several possible ratings is then proposed. After selection of the drive type, enter its 
name and node number (address on the fieldbus). 
 
After validation, a new item is created in the treeview and a default parameter file corresponding to the 
selected drive is automatically saved in its directory. 
 
7.4 Remove drives from a project 
 
A drive is removed by selecting "Remove a device" after a right mouse click on the project name in the 
treeview,  or  by  a  direct  right  mouse  click  on  the  drive,  in  the  tree,  and  by  selecting  "Remove" 
<drive_name>  from  the  project,  or  also  from  the  menu  bar,  by  selecting  "Project"  then  "Remove  a 
device". 
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7.5 Saving a project 
 
For saving a project, select the "File" menu, then "Save project". 
 
For saving a project with another name, select "Save project as ..." in the "File" menu. 
 
Note: When starting the software, the last project used is loaded in by default, but the software can 
also be launched by double-click on a project file (.prj). 
 
7.6 Archiving a project file 
 
Archiving a project groups all files of a project as well as its tree in a ZIP file. It offers the advantage of 
transferring a project to another PC. 
 
For archiving a project, select "Archive the project" in the "File" menu, then select a name for the ZIP 
file. 
 
7.7 Unarchiving a project file 
 
For unarchiving a project, select "Unarchive the project" in the "File" menu, then select the archive ZIP 
file and an output directory. 
 
The project is then unarchived and the user gets proposed to open it. 
 
7.8 Automatic creation of a project 
 
If the project structure for starting communicating with an application is not available, the user can then 
use  the  "Scan"  function.  This  function  searches  all  drives  connected  to  the  bus  and  starts  the 
communication. A temporary project is then automatically created with the list of detected drives. 
 
Click  at  first  on  the  "Scan"  button  in  the  shortcut  bar.  Select  the  communication  type  (RS232  or 
CANopen), the COM port number or the peripheral, the communication speed and the address field of 
the application drives. 
 
After validation, a window is displayed that allows the control of the procedure progressing. 
 
New items corresponding to the detected drives are displayed in the treeview and a temporary project 
is created in the directory "My documents / GemDriveStudio / MyProject". 
 
This temporary project can be definitely saved by selecting "Save project" in the "File" menu. 
 
7.9 Context menus 
 
In the navigation treeview, a right mouse click allows the access to a context menu:  
 
a/ By clicking on the project name, the user can: 
 - add a drive, 
 - delete a drive, 
 - display the properties of the project, 
 - open the Windows explorer in the project directory. 
 
b/ By clicking on a drive, the user can: 
 - remove this drive from the project, 
 - connect or disconnect the drive, 
 - change the Node ID of the drive, 
 - change the drive name, 
 - add/delete a source file (only for programmable drives). 
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8. Connecting the drives 
 
8.1 Connection to one drive 
 
The communication with one drive, in the project, is established by a right mouse click on the node, in 
the project tree, and by selecting "Connect". 
 
If no peripheral has been started, a configuration window of the communication is displayed. It allows 
selecting the peripheral type as well as the communication speed. 
 
8.2 Connection to all drives 
 
The "Connect/Disconnect" button in the shortcut bar starts the communication with all drives of the 
project tree in the increasing address order. 
 
8.3 Configuration of the communication 
 
The configuration window of the communication allows the type selection of the peripheral used for 
communicating with the devices. According to the selected peripheral, the use must select the card 
type, the communication speed, etc. 

8.3.1 The hardware peripherals 
 
The peripherals presently implemented in the communication server are: 
 
A/ The serial link 
 
When selecting this peripheral, the user must select the COM port ID as well as the communication 
speed. The available COM ports can be native ports of the PC or the software ports used for a USB 
=> RS232 adapter. 
 
B/ The CAN bus 
 
Only the peripherals developed by IXXAT are supported. 
 
The user must select the CAN card type to be used, the communication speed and the SDO channel. 
 
One of both SDO1 and SDO2 channels can be selected. 
 
In standard, the channel SDO1 is used for the connection between a device and the PC, and the 
channel SDO2 for the communication between the devices themselves. 
 
If a numerical controller is connected to the application, it will use the SDO1 channel. In this case, if 
the user wants to connect a PC and use the Gem Drive Studio software, he will have to select the 
SDO2 channel for configuring the communication. 
 
C/ The EtherCAT® bus 
 
This bus only concerns devices able to manage the EtherCAT® protocol.  
When selecting this peripheral, the user can choose a network card or launch a procedure allowing the 
automatic detection of the network card to which a slave device is connected. 
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8.3.2 The simulator 
 
The simulator prepares the parameterization of one or several device(s) without having these devices 
physically connected. 
 
The simulator is a virtual peripheral which can be selected in the communication configuration window. 
When this peripheral is selected, all devices defined in the project are simulated. 
 
In order to get a device simulated, the device directory of the project must contain a file with name 
DRIVEPAR.TXT. 
 
The simulated devices are marked with a blue bullet in the navigation tree. 
 
All parameterization windows can be used with the simulator except for the firmware update in the file 
management window.  
 
Use of the simulator for analysing an existing project: 
 
The content of the parameterization windows is initialized with the values contained in the device 
parameter files. 
 
Use of the simulator for preparing an off-line parameterization: 
 
Off-line: 
 
- Define a new project and add the application devices. 
- For each device, adjust the parameters in the various parameterization windows. 
- Use the "Backup" function for generating and saving the parameter files. 
- If required, use the archiving function allowing the transfer of the project to another PC. 
 
On the PC connected to the application: 
 
- Open the project previously created off-line after having unarchiving it, if it has been created on  
  another PC. 
- In the communication configuration window, select a hardware peripheral. 
- Use the "Restore" function for transferring the parameter files to the connected devices. 

 
8.4 "Scan" function 
 
The "Scan" button in the shortcut bar allows the searching of all drives connected to the bus and the 
communication start. The user can select the communication type (RS232, EtherCAT® or CANopen), 
the  COM  port  number  or  the  peripheral,  the  communication  speed  and  the  address  field  of  the 
application drives. 
Note: If a drive available on the bus is not detected, check that its address actually belongs to the 
addresses to be scanned, and check the connections. 
 
The "Scan" function is not available if the selected peripheral is the simulator. 
 
8.5 Multi-axis devices without address micro-switches 
 
The standard addresses, for this device type, are 1, 2 and 3. These addresses can be changed in the 
menu "Tools/ Node ID setting". After the saving of these parameters, the new addresses are taken into 
account at the re-start of the device. 
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9. The "templates" 
 
9.1 Introduction 
 
The  "Device  Config"  window  accessible  in  the  parameterization  tree  "Parameter  setting"  of  a  drive 
allows selecting, in a list (filed by family), a pre-defined drive configuration according to the required 
application  type  (analog  speed  drive,  stand-alone  positioner,  …).  This  configuration  concerns  the 
inputs  and  outputs  allocation  as  well  as  the  operation  mode.  When  a  pre-defined  configuration 
(Template) is selected, the drive parameterization tree "Parameter setting" only displays the 
parameters  pertaining  to  this  application.  This  function  allows  a  quick  configuration  of  the  drive  for 
standard applications. The user can return at any time to the complete configuration mode by selecting 
"Expert" in the list of the "Device Config" window.  
 
Only the authorized user (administrator) can apply a pre-defined configuration to the drive. 
 
9.2 Selection of a "template" 
 
 Open the "Device Config" window accessible in the parameterization tree "Parameter setting" of a 

drive; 
 Choose, in the lists ("Family" and then "Template"), a pre-defined drive configuration according to 

the required application; 
 Select the "Apply selected configuration" command in order to simultaneously configure the drive 

and the software parameterization tree.  
 
9.3 Import of a "template" 
 
The menu "Tools/Template files"/"Import new template archive" allows the selection of an archive file 
(.Zip format) containing the files required for importing a new template.  
 

10. The wizard procedures 
 
Wizard procedures are guiding the operator by automatically opening and closing the parameterization 
windows while displaying instructions regarding the currently displayed window. The commissioning of 
a new motor is an example of wizard procedure. 
The wizard procedures are accessed by the menu "Tools/Wizard procedures" or by clicking on the 
magic wand symbol. 
 
Select the appropriate drive and the procedure, then click on the start button and follow the 
instructions. 
 
During the progress of a wizard procedure, the drive control window is continuously displayed. This 
allows the re-initialization of possible errors in the drive during the procedure. 
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11. Motor catalogue 
 
11.1 Access to the catalogue 
 
The management window of the motor catalogue is accessed via the "Tools/Motor catalogue" menu. 
 
When the user selects this catalogue window, the software analyses all files of the "Motors" directory 
and creates a treeview corresponding to the motors found. 
  The motor classification criteria are the following: 

o the manufacturer, 
o the supply voltage, 
o the sensor type. 

  A motor is identified by: 
o the manufacturer 
o + the model 
o + the special code/customization. 

  There is one XML file per manufacturer. 
 
11.2 Management of the catalogue 
 
a/ Modify the parameters of the selected motor ("Edit" button). 
 
b/  If  a  motor  is  selected,  remove  it,  or  remove  a  complete  file  if  no  motor  is  selected  ("Remove" 
button). 
 
c/ Define and add a new motor (button "Add new motor") in the UserMotor.xml file (by default) or in 
another file. 
 
d/ Search and add a new motor file in the catalogue ("Import" button). The import of a new motor list is 
similar to adding a compatible XML file in the application "Motors" directory. If a file with same name is 
already existing in the catalogue directory, a message will inform the user and ask for confirming the 
replacement of the existing file. 
 
There is a difference between the "Manufacturer" motor files and the "User" motor files: 
 
- A "Manufacturer" motor file contains the motors of a same manufacturer. Modifying parameters or 

adding/removing a motor in these files is not possible. 
- The "User" motor files contain the motors defined by the user. 

11.2.1 Importing a new motor file in the catalogue 

 
For importing a new file in the motor catalogue, click on the "Import" button. A dialog box then allows 
to search and add a new motor file. 
 
Importing  a  new  motor  list  is  similar  to  adding  a  compatible  XML  file  in  the  application  "Motors" 
directory. If a file with same name is already existing in the catalogue directory, a message will inform 
the user and ask for confirming the replacement of the existing file. 
 
Files which are already in XML format as well as files issued from the VDSetup software tool (.dat 
format) can be imported. Those will be automatically converted into XML format. 

11.2.2 Removing a motor from the catalogue 

For removing a motor from the catalogue, select the file, then the motor, and click on the "Remove" 
button. 
Only "User" files can be removed. 
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11.2.3 Modifying a motor in the catalogue 

For modifying a motor in the catalogue, select the file, then the motor, and click on the "Edit" button. 
Only "User" files can be modified. 
 
Scroll down the various parameter tabs by clicking on the "Next" button until the backup of the motor 
selected in the file. 

11.2.4 Creation of a new motor 

For creating a new motor, click on "Add new motor" and fill-in the various fields of the following tabs by 
validating each step with the "Next" button. 
 
Step 1: Feedback sensor 
Step 2: Position sensor 
Step 3: Motor T° sensor 
Step 4: Motor control 
Step 5: Identification and parameters. 
 
The new motor can be saved into the UserMotor.xml file by default or into a new file. 
 

12. Application parameters 
 
The parameterization tree "Parameter setting" of a drive allows configuration and parameter 
adjustment according to the application type. 
 
The window "Device infos" contains all identification data of the device, i.e. type, rating, versions, etc. 
 
The window "Power supply config" allows the definition of the operating voltage and indication of the 
braking resistor type. 
 
The user can choose, in a list of the "Device Config" window, a pre-defined configuration of the drive 
(templates)  for  standard  applications  (analog  speed  drive,  stand-alone  positioner,  stepper  motor 
emulation, …).  
In the "Motor Config" window, the user can select the motor used in the motor catalogue or directly 
enter the parameter values of a motor that is not mentioned in the catalogue. 
 
The "Position Sensor" window concerns the parameters of the position sensors used in the 
application. The sensor used for the motor control (resolver or encoder) as well as the position scaling 
in the user units are selected in this window. 
 
The  "Controller"  window  concerns  the  speed  and  position  regulator  parameters.  The  "Auto-tuning" 
functions as well as the following error detection threshold adjustment are selected in this window. 
 
The other windows of the tree are depending from the selection of a pre-defined drive configuration or 
from the "Expert mode" selection. With the "Expert mode" selection, all parameters are accessible in 
the various menus. When selecting a pre-defined configuration, only the parameters required for the 
application are displayed. 
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13. Saving/restoring files in a drive 
 
According to its type, each drive may contain some files that are necessary to its parameterization but 
also to its operation in the application. 
 
There are several file types: standard parameters, user parameters, sequences, templates, etc. 
 
The  saving/restoring  allow  the  reading  of  these  files  in  the  drive  for  saving  them  on  the  hard  disk 
(project directory) or, on the contrary, to parameterize and configure a drive from the files previously 
saved in the project. 
 
13.1 Saving/restoring parameter files in a drive 
 
Saving/restoring parameter files only can be made by selecting the item "Parameter files" in the 
navigation tree of a drive. 
 
The displayed window allows: 
 
- launching the creation procedure of the standard parameter file (DRIVEPAR.TXT) in the drive, 
- the backup of this file on the hard disk (project directory), 
- restoring this file in the drive, from a previous backup. 
 
It is also possible, in the same window, to save/edit/restore the file containing the user parameters 
(USER_PAR.TXT). 
 
13.2 Saving the application files 
 
Saving the application files consists in reading, in the application drives, all files required for this 
application, i.e. the parameter files, sequences, templates, etc., and to copy them on the hard disk, in 
a backup directory of the project. 
 
The "Tools"/"Drive files backup" menu or its pertaining shortcut button allow the display of the backup 
window. 
 
The various possible options are: 
 
a/ "Backup from the project directory" 
This function can be selected offline and allows the copy of all files from the drive directories to the 
backup directory. 
 
b/ "Backup from the drive" 
This function launches the reading of all files from the application drives to the directory of each drive 
in the project, and to copy these files from these directories to the backup directory. 
 
c/ "Copy backup files to removable media" 
This function allows the copy of the content of the backup directory to a removable media such as a 
USB key or a memory card. 
 
13.3 Restoring the application files 
 
Restoring the application files consists, for one or several drives, in updating its/their files from a 
backup directory located on a hard disk or on a removable media. 
 
The "Tools"/"Drive files restore" menu or its pertaining shortcut button allow the display of the 
restoration window. 
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The various possible options are: 
 
a/ "Restore all the application" 
 
The  user  can  select  a  directory  containing  saved  files.  These  files  are  then  restored  in  the  various 
application drives. 
 
b/ "Restore only 1 device" 
 
The user can select one of the connected drives and then select a directory containing saved files. 
Only the files pertaining to a selected drive will be restored. 
 

14. Programming 
 
On programmable drives, the "Device Programming" menu, in the drive parameterization tree, allows 
the edition of source files saved in the project drive directory. The "Program" menu of the menu bar 
provides access to the programming tools. The use of the programming tools is described in the drive 
Programming Guide. 
 

15. Sequence editor 
 
The sequence editor is launched in the "Sequence mode" menu of the drive parameterization tree. 
The motion sequence parameterization is described in the drive User Guide. 
 
The  files  containing  sequence  records  are  named  as  SEQUENCE.TXT  and  are  saved  in  the  drive 
directory. 
 
 The  "File"  menu  allows  the  creation,  opening  and  saving  of  a  sequence  file.  It  also  allows  the 

printing of the sequence list and its parameters. 
 
 With the "Edit" menu, the user can copy, paste and delete sequences. 
 
 The "Transfer" allows the reading/writing of a sequence file in the drive. 
 

16. The file system 
 
The functions of the file system are accessible in the menu "Tools/File service". 
 
The window "File service" allows: 
 
- the display of the file system content of a device, 

- the reading/writing/removing of files in the device memory, 

 
- the selection of a file containing parameters and writing these parameters one after the other in the  
  device, 
 
- the update of the internal software of a device, for devices supporting this function and under the 
condition of using a communication interface other than EtherCAT®. 
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17. The dialog terminal 
 
In the dialog window, the user can read or modify a parameter value by selecting it with its name or via 
its indexes and sub-indexes.  
 
17.1 Start via the main interface 
 
The terminal can be started via the main Gem Drive Studio interface by clicking on the appropriate 
short-cut or by selecting the "Tools/Dialog window" menu. 
 
In  this  case,  the  communication  parameters  are  those  of  the  project,  and  the  list  of  the  drives 
accessible via the terminal corresponds to the list of drives connected in the project. 
 
17.2 Start in stand-alone mode 
 
The  dialog  terminal  can  also  be  launched  in  stand-alone  mode  by  clicking  on  the  "Gem  Drive 
Terminal" icon of the desktop, or via the "start" menu of Windows. 
 
In  this  case,  the  communication  parameters  must  be  defined  by  selecting  "Configuration”  and  then 
”Communication configuration". 
Select "File” and then ”Connect to the fieldbus" for establishing the communication with the selected 
node numbers.  
 
17.3 Use 
 
Four identical frames allow the reading/writing of the parameters. 
 
The data display type (decimal or hexadecimal) is selected via the menu "Configuration/View" or by 
means of the hot keys CTRL+D and CTRL+H. 
 
The  terminal  display  can  always  be  kept  in  the  foreground  with  regard  to  the  other  applications  by 
selecting the "Configuration/Window always on top" menu. 
 
A/ Reading a parameter on a drive: 
 
 Select the drive (Node), 
 Select a parameter by its name or by entering its index and sub-index, 
 Click on button "Read". 

 
Note: when ticking off the box of the "Read" button, the reading is continuously refreshed.  
 
B/ Writing a parameter on a drive: 

 
 Select the drive (Node), 
 Select a parameter by its name or by entering its index and sub-index, 
 Enter the parameter value in the data area, 
 Click on button "Write". 

 
Note: In hexadecimal mode, there is no need for entering neither spacings between the digits nor the 
non-significant 0. 
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18. The oscilloscope 
 
The oscilloscope function allows the signal display and analysis in the drive. 
 
18.1 Start via the main interface 
 
The oscilloscope can be started via the main interface of the Gem Drive Studio software by clicking 
on the appropriate short-cut or by selecting the "Tools/Oscilloscope" menu. 
 
In this case, the communication parameters are those of the project and the list of drives accessible 
via the oscilloscope corresponds to the list of the drives connected in the project. 
 
18.2 Start in stand-alone mode 
 
The  can  also  be  launched  in  stand-alone  mode  by  clicking  on  the  "GemDrive  Oscillo"  icon  of  the 
desktop or via the Windows "start" menu. 
 
In  this  case,  the  communication  parameters  must  be  defined  by  selecting  "Configuration”  and  then 
“Communication configuration". 
Then, select "File/Connect to the fieldbus" for establishing the communication with the selected node 
numbers. 
 
18.3 Use 

18.3.1 Menus 

 
The oscilloscope is made of a resizable screen allowing the curve display and of a 
control/parameterization panel. 
 
The signal selection is made from the CANopen objects (index and sub-index). 
 
The signal size can be 16 bits or 32 bits. 
 
The signal types are the following: 
 
 analog ("continuously" varying signal between minimum value and maximum value),  

 
 or logic (each bit is a logic signal). The logic signals are contained in one 16 or 32 bit word. 
 
The menu bar provides access to the following adjustment panels: 
 
"File/Connect" menu: 
 
Establishes the communication with the drives selected in the communication configuration window. 
 
"File/Load from .osc file" menu: 
 
Uploads and displays the curves saved in an .osc file. 
 
"File/Save to .osc file" menu: 
 
Saves the displayed curves in an .osc file. 
 
"File/Load from an Excel file" menu: 
 
Uploads and displays curves saved in an .xls file. 
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"File/Export to an excel file" menu: 
 
Saves the displayed curves in an .xls file. 
 
"File/Exit" menu: 
 
Closes the application. 
 
"Edit/Copy screen to the clipboard" menu: 
 
Copies the displayed curves and their features to the clipboard for inserting them into a document. 
 
"Configuration/Communication configuration" menu: 
 
This menu is to be used for selecting the communication type and list of drives (addresses) the user 
wants to connect. 
 
"Configuration/Channel configuration" menu: 
 
In this menu, the user selects the signals to be displayed for each of the 4 oscilloscope channels. 
 
The signal selection is made by choosing the appropriate drive, in the list, and from the CANopen 
objects (index and sub-index). 
 
The signal size can be 16 bits or 32 bits. 
The signal types are the following: 
 
 analog ("continuously" varying signal between minimum value and maximum value),  

 
 or logic (each bit is a logic signal). The logic signals are contained in one 16 or 32 bit word. 
 
The signal acquisition in multi-axis mode requires a special configuration of the drives (the triggering is 
managed by PDO messages) except for natively multiaxis devices. 
 
If the "multiaxis configuration" box is not ticked off, the selection of a drive on channel 1 automatically 
involves the selection of this same drive on the other channels. The selection of the drives on the other 
channels is inhibited. 
 
If the "multiaxis configuration" box is ticked off, the drive list is re-initialized and contains only the 
drives supporting the multi-axis mode. In this mode, the user can select a different drive for each of the 
oscilloscope channels. 
 
Important notes:  
 
a/ The PDO4 is used for the triggering synchronization in multi-axis mode. Check, in that case, that the 
PDO is not used by the application. This restriction does not concerned natively multiaxis devices. 
 
b/ The multiaxis mode does not work if a communication via EtherCAT® has been selected. 
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"Configuration/Trigger configuration" menu: 
 
This menu allows the selection of the triggering mode and channel. 
 
Three triggering types can be selected: 
 
A/ Analog triggering: 
 
 - high-level triggering, 
 - low-level triggering, 
 - on rising edge, 
 - on falling edge. 
 
B/ Triggering on Error. 
 
C/ Digital triggering (16 bit word): 
 
 - on value of one or several bits, 
 - on status change of one or several bits. 
 
"Configuration/Screen configuration" menu: 
 
In this menu, the user can select, for each channel, the curve colour and shape: 
 
 - dots, 
 - connected dots, 
 - discret, 
 - only one bit. 
 
The user can also choose the grid type and colour, the display screen colour and the curve thickness. 
 
"Configuration/Window always on top" menu: 
 
This option keeps the oscilloscope in the foreground with regard to the other applications. 
 
"Tools/Measurements" menu: 
 
Level (cursors V1 and V2) and time (cursors T1 and T2) measurements can be made on the displayed 
curves. 
 
This menu allows the display/hiding of the cursors, and associating the level measurement cursors to 
the oscilloscope channels. 
 
"Tools/Auto-offset" menu: 
 
This function recenters the selected curve on the Y axis with regard to the intersection value of this 
curve with the T1 cursor. 

18.3.2 Display window 

 
The display window consists of two parts: 
 
 - the curve display, 
 - the measuring data display. 
 
Using the left mouse button: 
 
- For moving the measurement cursor and the triggering line (trig), 
 
- For moving the "T" mark indicating the triggering moment on the X axis (time). 
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Using the right mouse button: 
 
- on the screen, for selecting the automatic curve scaling or for displaying/hiding the measurement 
cursors, 
 
- on the triggering line (trig), for selecting the triggering type, 
 
- on cursor T1 for refocusing a curve on the Y axis (offset), 
 
- on cursors V1 or V2 for displaying the corresponding level values in the measurement display frame, 
 
- on a value, in the measurement display frame, for copying this value to the clipboard and insert it into 
a document. 

18.3.3 Control/adjustment window 

 
In the "Channels" frames 1 to 4 the user can: 
 
 - display/hide a curve, 
 - reverse a curve, 
 - adjust offset and amplitude of a signal. 
 
The "Display" frame allows: 
 
 - selecting the time base value, 

- modifying the triggering value (modifies the "T" mark position on the display screen), 
 - selecting a display of Channel 2 = fct (Channel 1), 
 - zooming/scrolling the displayed curves. 
 
The "Trigger" frame allows: 
 
 - displaying/hiding the triggering line, 
 - entering the triggering level, 
 - starting/stopping the acquisition, 
 - transferring the curves, 

- changing the display resolution (for accelerating the transfer times by reducing the data   
  volumes), 

 - displaying, for each channel, the transfer status (green LED: acquisition stopped, yellow  
  LED: data currently saved, red LED: waiting for the triggering, purple LED: waiting for the  
  delay time). 

 
Note: After the start of an acquisition, the level and the value of the signal selected for the triggering 
channel  are  displayed  on  the  left  side  of  the  curves  display  screen.  These  continuously  refreshed 
information allow an easier adjustment of the triggering level. 
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19. Troubleshooting 
 
19.1 "Unexpected error" when starting the software 
 
Right click the software icon and select "Start as an administrator". 
 
 
19.2 The IXXAT peripheral is not displayed in the peripheral list 
 
After rebooting the PC, the new peripheral is generally detected. Otherwise, disconnect and reconnect 
the peripheral. Windows then proposes to install the driver. The automatic installation is 
recommended. 
 
19.3 The communication with a new IXXAT peripheral is not possible 
 
If an older IXXAT driver is already existing in the PC, the peripheral may use the older driver instead of 
the new one which has just been installed. In this case, the software will not work properly. In order to 
force the peripheral to use the new driver, the peripheral must be searched via the "Configuration 
panel/System" menu, then "Material and Peripheral Manager". Search the IXXAT peripheral in the list 
and select "Update the driver" by a right mouse click. Select the automatic installation. Windows shall 
the select the more recent driver version. 
 
19.4 Texts and captions are empty. The word < string> is displayed on the 
buttons 
 
The  software  questions  the  Windows  registry  for  getting  the  location  of  the  "Application  data"  and 
"Shared documents" directories. These directories contain the files required for running the software, 
such  as  translation,  motor  lists,  object  dictionaries,  etc.  In  some  rare  cases,  the  registry  keys  may 
have been modified by the installation of some softwares which force the value of these keys instead 
of reading them for knowing their value. 
 
The correct keys for Windows XP are the following:  
 
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell Folder\Common AppData = 
C:\Documents and settings\All Users\Application Data 
and 
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell  Folder\Common  Documents  = 
C:\ Documents and settings\All Users\Documents 
 
The correct keys for Windows Seven are the following: 
 
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell Folder\Common AppData = 
C:\ProgramData 
and 
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell  Folder\Common  Documents  = 
C:\ Users\Public\Documents 
 
19.5 The software information window displays "parameter unknown" 
 
The object dictionary used for the connection with the drive is incomplete or corrupted. Re-install the 
software for updating the dictionary library. 
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